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Section 1: Overview of SQL and Oracle Database Configuration

 Overview of Database Configuration 

Special Instructions for Configuring Databases 

For your convenience this document pulls the information on database configuration out of the hp 
OpenView Reporter Installation and Special Configuration Guide and includes it with your Internet 
Services product.

Overview

Internet Services and Reporter share the same database for storing performance and reporting 
information. 

The default database for Internet Services is Microsoft SQL Server 2000 Desktop Engine (MSDE).    

 IMPORTANT: When upgrading from a previous version of OVIS or Reporter the minimum 
requirement for SQL Server 2000/MSDE is now Service Pack 3 or 3a.  This Service Pack is required to 
deal with vulnerability in SQL Server 2000 to destructive computer viruses (such as the SLAMMER 
worm virus). Please upgrade your database instance before installing OVIS.  

You may choose to change the database to one of the following supported databases:

●     Oracle 9.2 for Solaris or HP-UX
●     Oracle 10.1.0 for Solaris or HP-UX
●     SQL Server 2000
●     SQL Server 2005
●     SQL Express 2005

WARNING: Migration of data from a different database to the new SQL Server or Oracle database is 
not supported for Internet Services.  And if you have OVIS and Reporter on the same system, 
attempting to migrate Reporter data to the new database may result in problems in OVIS.

There are several database configurations possible depending on which OpenView products you have 
installed. See the following scenarios:
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Section 1: Overview of SQL and Oracle Database Configuration

If you have Reporter already installed on the same 
system as Internet Services will be installed.

When you install OVIS, it will detect whatever 
database is configured for Reporter and use this 
same database. The OVIS installation configures a 
connection to this database and adds table entries 
for OVIS as needed.

If you do not have Reporter and are installing 
Internet Services for the first time.

The MSDE default database is installed. You can 
later use instructions in this guide for configuring 
an Oracle or SQL Server 2000 or SQL Server/
Express 2005 database instead.

If you do not have Reporter and are updating from 
a previous version of Internet Services to this 
version. 

The upgrade uses the existing database where 
possible.

Using this guide

The information in this guide was taken from the Reporter documentation. The database configuration 
procedures are almost identical for Reporter and Internet Services 

References to using the Reporter GUI to configure Oracle database logins are replaced with 
instructions for using the OVIS Configuration Manager to configure the Oracle database logins.
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Section 2: Configure SQL Server as the Database

 Configure Microsoft SQL Server as the Database 

 

Internet Services now uses MSDE  (Microsoft SQL Server Desktop Engine) as the 
default database. The MSDE version that is used is a subset of SQL Server 2000, which 
means that much of the SQL 2000 functionality is present in the MSDE database, even 
though no dialogs are available to assist in the configuration. MSDE has a 2GB size limit 
per database instance. Knowing this, you may at some point choose to change to a SQL 
Server 2000 database or a SQL Server 2005 database. 

Upgrade: When upgrading from MSDE to SQL Server 2000 follow the instructions 
provided by Microsoft and choose the OVOPS instance to upgrade.  

When upgrading from MSDE to SQL Server 2005 you can upgrade to SQL Server 2005 
Express Edition or upgrade to SQL Server 2005 Workgroup Edition but not directly to 
the SQL Server 2005 Enterprise Edition. Follow the instructions provided by Microsoft 
and choose the OVOPS instance to upgrade. An example of an upgrade from MSDE to 
SQL Server 2005 Express Edition is provided at the end of this section.

New Database: The instructions for changing to a new SQL Server 2000 or 2005 
database (rather than upgrading from MSDE) are contained in the link below.  These 
instructions could be used when installing SQL Server 2000 or SQL Server 2005 on a 
remote system.  

 IMPORTANT: Do not connect multiple copies of Internet Services to the same 
database as unexpected results occur when more than one copy of OVIS attempts to 
write data to the configured database. 

 IMPORTANT: Migration of data from your old database to the new SQL Server 
database is not supported for Internet Services (OVIS).  And if OVIS is on the same 
system as hp OpenView Reporter, attempting to migrate Reporter data to the new 
database may result in problems in OVIS.

 IMPORTANT: When upgrading from a previous version of OVIS or Reporter the 
minimum requirement for SQL Server 2000/MSDE is now Service Pack 3 or 3a.  This 
Service Pack is required to deal with vulnerability in SQL Server 2000 to destructive 
computer viruses (such as the SLAMMER worm virus). Please be sure you have 
upgraded your database instance before installing OVIS.  
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Section 2: Configure SQL Server as the Database

■     Configure Microsoft SQL Server 2000 as the database.
■     Configure Microsoft SQL Server 2005 as the database.
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 Configure SQL Server 2000 as the Database

 Set Up Microsoft SQL as the Database 
Configure SQL Server 2000  

Set Up SQL Server 2000 as the Database

 

Internet Services uses the MSDE (Microsoft SQL Server Desktop Engine) as its default database. The MSDE 
version that is used is a subset of SQL Server 2000, which means that much of the SQL 2000 functionality is 
present in the MSDE database, even though no dialogs are available to assist in the configuration. MSDE has 
a 2GB size limit per database instance. Knowing this, you may at some point choose to change to an SQL 
Server 2000 database. When upgrading from MSDE to SQL Server 2000 follow the instructions provided 
by Microsoft and choose the OVOPS instance to upgrade. 

Since the Internet Services product does use an MSDE instance name (OVOPS) you will see the 
instance name when using SQL Server 2000 Enterprise Manager to look at the database. The 
corresponding SQL Server 2000 examples will not use the instance name since you are not required to 
use an instance name wtih SQL Server 2000. 

  When upgrading from a previous version of OVIS or Reporter the minimum requirement for SQL 
Server 2000/MSDE is now Service Pack 3 or 3a.  This Service Pack is required to deal with 
vulnerability in SQL Server 2000 to destructive computer viruses (such as the SLAMMER worm virus). 
Please upgrade your database instance before installing OVIS.  

  Migration of data from your old database to the new SQL Server database is not supported for 
Internet Services (OVIS).  And if OVIS is on the same system as hp OpenView Reporter, attempting to 
migrate Reporter data to the new database may result in problems in OVIS.

 IMPORTANT: If you use systems with different language settings, the OVIS Reporter database 
should be created using the same default locale character set as the system where OVIS is installed 
(Management Server). At this time, OVIS does not support databases that have been configured to use 
the UTF-8 character set.

Database Performance Note:

Adding indexes can improve performance. With OVIS 5.2 indexes were added to the following tables. 
Consult your DBA for a maintenance plan for these indexes.
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 Configure SQL Server 2000 as the Database

IOPS_PROBE_DATA

Index Field

Indx2_IOPS_PROBE_DATA DATETIME

Indx6_IOPS_PROBE_DATA CUSTOMER_NAME

Indx7_IOPS_PROBE_DATA SERVICE_NAME

Indx25_IOPS_PROBE_DATA PROBENAME

IOPS_PROBE_DATA_CACHE

Index Field

Indx2_IOPS_PROBE_DATA_CACHE DATETIME

Indx6_IOPS_PROBE_DATA_CACHE CUSTOMER_NAME

Indx7_IOPS_PROBE_DATA_CACHE SERVICE_NAME

Indx25_IOPS_PROBE_DATA_CACHE PROBENAME

IOPS_PROBE_DATA_DAILY

Index Field

Indx2_IOPS_PROBE_DATA_DAILY DATETIME

Indx6_IOPS_PROBE_DATA_DAILY CUSTOMER_NAME

Indx7_IOPS_PROBE_DATA_DAILY SERVICE_NAME

Indx25_IOPS_PROBE_DATA_DAILY PROBENAME

IOPS_DETAIL_DATA

Index Field

Indx5_IOPS_DETAIL_DATA DATETIME

Indx7_IOPS_DETAIL_DATA PROBENAME

Indx8_IOPS_DETAIL_DATA CUSTOMER

Indx11_IOPS_DETAIL_DATA SERVICENAME

IOPS_DETAIL_DATA_HOURLY

Index Field
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 Configure SQL Server 2000 as the Database

Indx5_IOPS_DETAIL_DATA_HOURLY DATETIME

Indx7_IOPS_DETAIL_DATA_HOURLY PROBENAME

Indx8_IOPS_DETAIL_DATA_HOURLY CUSTOMER

Indx11_IOPS_DETAIL_DATA_HOURLY SERVICENAME

IOPS_DETAIL_DATA_DAILY

Index Field

Indx5_IOPS_DETAIL_DATA_DAILY DATETIME

Indx7_IOPS_DETAIL_DATA_DAILY PROBENAME

Indx8_IOPS_DETAIL_DATA_DAILY CUSTOMER

Indx11_IOPS_DETAIL_DATA_DAILY SERVICENAME

 
 

The following tasks are documented for setting up SQL Server 2000 as the database for OVIS. The 
first section of this procedure covers configuring the SQL server system. The second section covers 
configuring an ODBC connection as well as Internet Services configuration as an SQL Server account. 

Configure the SQL Server system. 
Task 1. Install SQL Server software. 
Task 2. Verify the trust relationship between client and server. 
Task 3. Configure the database on SQL Server.

Configure the ODBC Connection. 
Task 1. Install Internet Services. 
Task 2. Check MDAC Version is 2.71 or greater. 
Task 3. Establish the ODBC connection. 
Task 4. Configure Internet Services to use SQL as the database. 

Install & Configure SQL Server Software on Windows Server

If you have already installed SQL Server, you can skip Task #1. If your Internet Services system and 
the SQL Server system are in the same domain, you can skip task Task #2 and go directly to Task #3. 

Prerequisites include:  Windows 2000 Service Pack 3 or Windows XP Service Pack 1 and  Internet 
Explorer 5.5 with the latest service pack. 

 IMPORTANT: With SQL Server 2000, Service Pack 3 is required.
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 Configure SQL Server 2000 as the Database

Task 1  Install SQL 2000 Server Software

1.  Insert the SQL Server  2000 CD into the CD-ROM drive. 
2.  Select Install SQL  2000 Components. 
3.  Select Database Server – Standard Edition. 
4.  Select Local Computer and respond to prompts as they appear. 
5.  Be sure to use Mixed Mode for authentication.
6.  Restart the system.
7.  Be sure you are on SQL Server 2000 Service Pack 3.
8.  Restart the system.

Task 2  Verify Trust Relationship Between Client and Server 

Note: A trust relationship should be set up if the Internet Services client and SQL Server are in 
separate domains in Windows or if the client and server run on mixed systems. If the client and SQL 
Server are running on Windows 2000, skip this task. 

1.  Log on to the SQL Server-installed system with Administrator privileges.  
2.  From the Start menu select Programs>Administrative Tools>User Manager for Domains. 
3.  From the Policies menu select Trust Relationships. 

4.  In the Trusting Domains dialog box, look for the Domain where Internet Services is located. If 
the appropriate domain is displayed, continue to the next task. 
If not, add the trusting domains as needed. If you have questions about trusting domains, click 
the Help button (if Internet Services and SQL Server systems are in separate domains, you 
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 Configure SQL Server 2000 as the Database

must configure a trust relationship between the systems). 

Task 3  Configure the Database on SQL Server  2000

1.  From the Start menu select Programs>Microsoft SQL Server  2000 >Enterprise Manager.
2.  In the Microsoft Console Root window, select your SQL Server Group. 

3.  Right click on your SQL Server Group and select Properties.  Then go to the Security Tab and 
make sure that “SQL Server and Windows” is selected under Authentication in the Security part 
of the dialog. 
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 Configure SQL Server 2000 as the Database

4.  If your SQL Server system is not listed under the SQL Server Group, right-click SQL Server 
Group, select New SQL Server Registration from the drop-down menu and follow the wizard 
online steps to register.  

5.  Right-click Databases – New Database  
6.  In the General tab for the Name box, enter a name for the database (example uses  Reporter 

as the name). 

 

 Note: The SQL Server database no longer needs to be named Reporter.

6.  Select the Data Files tab and in the Database files segment, in the Initial size (MB) column, 
enter 100.

7.  Click OK to close the window.  
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 Configure SQL Server 2000 as the Database

  

8.  After the database is created, expand the Security folder in the left pane.  
9.  Right-click Logins under the Security folder and select New Login... 
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 Configure SQL Server 2000 as the Database

10.  Select General Tab and in the Name box enter the user name openview or your specified user.  
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 Configure SQL Server 2000 as the Database

  

11.  Under Authentication select the SQL Server authentication radio button and enter your 
password. 

12.  Under the Defaults, select Reporter (or whatever the database name is) from the Database list 
box. 

13.  Select the Database Access tab and under Database access check the Permit box that 
corresponds to Reporter. 

14.  Under Database roles for Reporter, check public and db_owner and select OK to exit. 
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 Configure SQL Server 2000 as the Database

15.  Confirm the new password from Step 11. 

 

 

To verify User has Database Access, in the left pane expand the security folder, or click the plus sign 
next to each item: Security>Logins and you should see openview in the right pane. 
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 Configure SQL Server 2000 as the Database

 

 

17.  Exit Enterprise Manager and go to the client system (where Internet Services is installed).

 

Configure ODBC Connection

Task 1  Upgrade or Install Internet Services            

1.  Install or upgrade Internet Services as needed. 

Task 2  Check MDAC Version is 2.71 or Greater 

MDAC is the Microsoft Data Access Component. You need to have an MDAC version of 2.71 or 
greater on the client system where Internet Services is located. Check the version number as follows: 

1.  Run regedit and locate the registry entry: HKEY_LOCAL_MACHINE\Software\Microsoft
\DataAccess

2.  In the Details pane, look in the Name column for FullInstallVer and Version. Each of these keys 
will have corresponding version information in the Data column.

3.  If the Data values are 2.71 or greater, skip to the next Task.
4.  If either of the Data values are less than 2.71.xxx.y, then go to the Microsoft web site and 
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 Configure SQL Server 2000 as the Database

download and install a current version of MDAC.

Task 3  Establish the ODBC Connection 

Important Note: Be sure that Internet Services is installed before beginning this step.  Also be 
sure that the  Configuration Manager is closed before beginning this step.

1.  Stop the following services: 
Reporter Service 
World Wide Web Publishing Service

2.  From a command window, stop the OVIS probes with the following command: 
ovc -stop ovprobes 
From a command window, stop tomcat with the following command: 
ovc -stop ovtomcatA

3.  From the Start menu select Settings>Control Panel and double-click Administrative Tools.  
Then double-click Data Sources (ODBC).

4.  In the ODBC Data Source Administrator window select the System DSN tab. Highlight Reporter 
and select the Remove button.

4.  Select the Add... button to create a new Reporter data source. 
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 Configure SQL Server 2000 as the Database

5.  In the Create New Data Source dialog box select the SQL Server driver and the Finish button.

 

6.  In the Create a New Data Source to SQL Server dialog, make sure that Reporter (or whatever 
the database name is) appears in the data source name box and the server name appears in 
the Server box. Then select Next. 
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 Configure SQL Server 2000 as the Database

7.  Select - With SQL Server authentication using a login ID and password entered by user.  
Also check the box for Connect to SQL Server to obtain default settings.   
Enter the login ID and password that you used in the first section Install & Configure SQL Server 
2000: Task 3  - Configure the Database on SQL Server  2000 of the previous section.  Then 
select Next.

file:///C|/hpovreports/Help/Concepts_Guide/section03B.htm (14 of 19)3/16/2007 11:25:15 AM

Page 19



 Configure SQL Server 2000 as the Database

8.  Check Change the default database to, select Reporter, (or whatever the database name is) 
and click Next.
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 Configure SQL Server 2000 as the Database

9.  Check Perform translation for character data and select Finish. 

10.  In the ODBC Microsoft SQL Server Setup dialog select the Test Data Source... button. 
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 Configure SQL Server 2000 as the Database

 

11.  Exit the SQL Server ODBC Data Source Test by clicking OK. 
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 Configure SQL Server 2000 as the Database

Task 4  Configure Internet Services to use SQL as the Database 

1.  To start OpenView Internet Services Configuration Manager, select  
Start>Programs>HP OpenView>internet services>Configuration Manager.

2.  If you see an error message; click Yes or OK to proceed.  The database login may be required, 
if so see the next step, proceed to step 5.  

3.  In the Database Login dialog box, enter the database User ID and Password that you used for 
the system configuration. 
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 Configure SQL Server 2000 as the Database

 

4.  Click OK. 
5.  You will see the  Internet Services Startup status bars . Then the Configure License dialog 

may be displayed.  Follow the instructions for licensing or click OK to continue. Then the  
main Configuration Manager window displays. You can exit the Configuration Manager. 
 

 

6.  Start the following services: 
Reporter Service 
World Wide Web Publishing Service

7.  From a command window, start the OVIS probes with the following command: 
ovc -start ovprobes 
From a command window, start tomcat with the following command: 
ovc -start ovtomcatA
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Configure SQL Server 2005 as the Database

 Set Up Microsoft SQL Server 2005 as the Database

Overview

This section contains instructions to setup Microsoft SQL Server 2005 as the database for HP OpenView Internet 
Services (OVIS).

When upgrading from MSDE to SQL Server 2005 you can upgrade to SQL Server 2005 Express Edition or upgrade 
to SQL Server 2005 Workgroup Edition. Follow the instructions provided by Microsoft and choose the OVOPS 
instance to upgrade. An example of an upgrade from MSDE to SQL Server 2005 Express Edition is provided.

The instructions for changing to a new SQL Server 2005 database (rather than upgrading from MSDE) are 
documented in this section. These instructions could be used when installing SQL Server 2005 on a remote system.  

 Do not connect multiple copies of Internet Services to the same database as unexpected results occur when 
more than one copy of OVIS attempts to write data to the configured database. 

 Migration of data from your old database to the new SQL Server database is not supported for Internet Services 
(OVIS).  And if OVIS is on the same system as hp OpenView Reporter, attempting to migrate Reporter data to the 
new database may result in problems in OVIS.

 IMPORTANT: If you use systems with different language settings, the OVIS Reporter database should be 
created using the same default locale character set as the system where OVIS is installed (Management Server). At 
this time, OVIS does not support databases that have been configured to use the UTF-8 character set.

NOTE:

●     Before installing Microsoft SQL Sever, consult with a Database Administrator (DBA). A database administrator 
can help you design and set up the database, including the creation of the tablespaces, for optimal use by 
OVIS. 

●     Before installing Microsoft SQL Server, refer to Microsoft documentation for recommended settings. 

Database Performance Note:

Adding indexes can improve performance. With OVIS 5.2 indexes were added to the following tables. Consult your 
DBA for a maintenance plan for these indexes.

IOPS_PROBE_DATA

Index Field

Indx2_IOPS_PROBE_DATA DATETIME
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Configure SQL Server 2005 as the Database

Indx6_IOPS_PROBE_DATA CUSTOMER_NAME

Indx7_IOPS_PROBE_DATA SERVICE_NAME

Indx25_IOPS_PROBE_DATA PROBENAME

IOPS_PROBE_DATA_CACHE

Index Field

Indx2_IOPS_PROBE_DATA_CACHE DATETIME

Indx6_IOPS_PROBE_DATA_CACHE CUSTOMER_NAME

Indx7_IOPS_PROBE_DATA_CACHE SERVICE_NAME

Indx25_IOPS_PROBE_DATA_CACHE PROBENAME

IOPS_PROBE_DATA_DAILY

Index Field

Indx2_IOPS_PROBE_DATA_DAILY DATETIME

Indx6_IOPS_PROBE_DATA_DAILY CUSTOMER_NAME

Indx7_IOPS_PROBE_DATA_DAILY SERVICE_NAME

Indx25_IOPS_PROBE_DATA_DAILY PROBENAME

IOPS_DETAIL_DATA

Index Field

Indx5_IOPS_DETAIL_DATA DATETIME

Indx7_IOPS_DETAIL_DATA PROBENAME

Indx8_IOPS_DETAIL_DATA CUSTOMER

Indx11_IOPS_DETAIL_DATA SERVICENAME

IOPS_DETAIL_DATA_HOURLY

Index Field

Indx5_IOPS_DETAIL_DATA_HOURLY DATETIME

Indx7_IOPS_DETAIL_DATA_HOURLY PROBENAME

Indx8_IOPS_DETAIL_DATA_HOURLY CUSTOMER

Indx11_IOPS_DETAIL_DATA_HOURLY SERVICENAME

IOPS_DETAIL_DATA_DAILY

Index Field

Indx5_IOPS_DETAIL_DATA_DAILY DATETIME
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Configure SQL Server 2005 as the Database

Indx7_IOPS_DETAIL_DATA_DAILY PROBENAME

Indx8_IOPS_DETAIL_DATA_DAILY CUSTOMER

Indx11_IOPS_DETAIL_DATA_DAILY SERVICENAME

The following tasks are documented for setting up SQL Server 2005 as the database for OVIS:

●     Install Microsoft SQL 2005 Server Software
●     Configure Microsoft SQL Server 2005 as the Database for OVIS 
●     Configure ODBC Connection

In addition the following upgrade task is documented at the end of this chapter:

Upgrading from MSDE 2000 to SQL Express 2005 

Install Microsoft SQL 2005 Server Software 

Before installing Microsoft SQL Server Software, for system requirements and other information, refer to the product 
documentation available online at: http://www.microsoft.com/sql/default.mspx

1.  Insert the Microsoft SQL Server 2005 CD into your CD-ROM drive. 
2.  Select to install MS SQL Server 2005. 
3.  The installation wizard appears. The examples in this document are for the SQL Server 2005 Enterprise 

Edition.
4.  In the Components to Install dialog, select SQL Server Database Services and select Workstation 

Components, Books Online and development tools this is needed to run SQL Server Management Studio. 
Click Next.

5.  In the Instance Name dialog, select Named Instance and enter or select an instance name. Click Next.
6.  In the Service Account dialog, select Use a domain user account and enter the user name, password and 

domain. Click Next.
7.  In the Authentication Mode dialog, select Mixed Mode (Windows Authentication and SQL Server 

Authentication) for authentication and enter the system administrator (sa) password. Click Next.
8.  Accept the defaults in the other dialogs as appropriate.
9.  Select the Install button. 

10.  Restart your system after the installation is complete. 

Configure Microsoft SQL Server 2005 as the Database for OVIS

To configure Microsoft SQL Server 2005 as the database for OVIS, do the following: 

1.  From the Start menu on the system with SQL Server 2005 installed, select Start -> Programs -> Microsoft 
SQL Server 2005 -> SQL Server Management Studio. 

2.  Enter your Login name and Password. In the Connect to Server dialog, select the Server Name and 
Windows Authentication and click Connect.  
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Configure SQL Server 2005 as the Database

 
 

3.  the Microsoft SQL Server Management Studio window appears.  
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Configure SQL Server 2005 as the Database

 
4.  From the left pane of Microsoft SQL Server Management Studio window, right-click Databases, and select 

New Database. The New Database window appears. 
 
 

  
 

5.  In the New Database window, enter a name for the database in the Database name text box (Example: 
Reporter as shown in the screen shot).  
When you create a new database, the following files will be automatically created: 

❍     a data file with the logical name same as the database name you specified (Example: Reporter as 
shown in the screen shot).

❍     a log file with the logical name same as the database name followed by _log (Example: Reporter_log 
as shown in the screen shot).

file:///C|/hpovreports/Help/Concepts_Guide/section3c_sql_server.htm (5 of 20)3/16/2007 11:25:17 AM

Page 29



Configure SQL Server 2005 as the Database

The database files are displayed in the Database files section, specify the value of the Initial Size (MB) of 
database file as 100 MB and log file as the default value which appears. Click Ok, to close the New Database 
window.

 
 

6.  In the Microsoft SQL Server Management Studio main window, from the left pane click Security to display the 
subitems in the tree. Right-click Logins and select New Login. 
 

 
 

7.  The Login - New window is displayed.  
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Configure SQL Server 2005 as the Database

 
 

8.  In the Login - New window left pane under Select a Page, click General. 

Enter the Login name, for example openview. 

Select SQL Server authentication and enter the password. 

Uncheck the option Enforce password policy. 

Select the Default database of Reporter from the drop-down list. 

 
 

9.  In the Login-New window left pane under Select a Page , click User Mapping.  
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Configure SQL Server 2005 as the Database

 
 

10.  From the Users mapped to this login section, select the Map corresponding to your database Reporter

Under Database roles membership for: Reporter, select db_owner and public. Click OK.

Exit out of the SQL Server 2005 Management Studio. The Microsoft SQL server 2005 database is now configured as 
the database for OVIS. 

Go to the client system where OVIS is installed to configure an ODBC connection to the SQL Server 2005 database.

Configure ODBC Connection
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Configure SQL Server 2005 as the Database

Task 1  Upgrade or Install Internet Services            

1.  Install or upgrade Internet Services as needed. 

Task 2  Check MDAC Version is 2.71 or Greater 

MDAC is the Microsoft Data Access Component. You need to have an MDAC version of 2.71 or greater on the client 
system where Internet Services is located. Check the version number as follows: 

1.  Run regedit and locate the registry entry: HKEY_LOCAL_MACHINE\Software\Microsoft\DataAccess
2.  In the Details pane, look in the Name column for FullInstallVer and Version. Each of these keys will have 

corresponding version information in the Data column.
3.  If the Data values are 2.71 or greater, skip to the next Task.
4.  If either of the Data values are less than 2.71.xxx.y, then go to the Microsoft web site and download and install 

a current version of MDAC.

Task 3  Establish the ODBC Connection 

Important Note: Be sure that Internet Services is installed before beginning this step.  Also be sure that the  
OVIS Configuration Manager is closed before beginning this step. 

1.  Stop the following services: 
Reporter Service 
World Wide Web Publishing Service

2.  From a command window, stop the OVIS probes with the following command: 
ovc -stop ovprobes 
From a command window, stop tomcat with the following command: 
ovc -stop ovtomcatA

3.  From the Start menu select Settings>Control Panel and double-click Administrative Tools.  Then double-
click Data Sources (ODBC).

4.  In the ODBC Data Source Administrator window select the System DSN tab. Highlight Reporter and select 
the Remove button.
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4.  Select the Add... button to create a new Reporter data source. 
5.  In the Create New Data Source dialog box select the SQL Server driver and the Finish button.

 

6.  In the Create a New Data Source to SQL Server dialog, make sure that Reporter (or whatever the database 
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name is) appears in the data source name box and the server name appears in the Server box. Then select 
Next. 

7.  Select - With SQL Server authentication using a login ID and password entered by user.  
Also check the box for Connect to SQL Server to obtain default settings.   
Enter the login ID and password that you used in installing the SQL Server  2005 software.  Then select Next.

file:///C|/hpovreports/Help/Concepts_Guide/section3c_sql_server.htm (11 of 20)3/16/2007 11:25:17 AM

Page 35



Configure SQL Server 2005 as the Database

8.  Check Change the default database to, select Reporter, (or whatever the database name is) and click Next.

9.  Check Perform translation for character data and select Finish. 

10.  In the ODBC Microsoft SQL Server Setup dialog select the Test Data Source... button. 
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11.  Exit the SQL Server ODBC Data Source Test by clicking OK. 
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Task 4  Configure Internet Services to use SQL as the Database 

1.  To start OpenView Internet Services Configuration Manager, select  
Start>Programs>HP OpenView>internet services>Configuration Manager.

2.  If you see an error message; click Yes or OK to proceed.  The database login may be required, if so see the 
next step, proceed to step 5.  

3.  In the Database Login dialog box, enter the database User ID and Password that you used for the system 
configuration. 
 

 

4.  Click OK. 
5.  You will see the  Internet Services Startup status bars . Then the Configure License dialog 

may be displayed.  Follow the instructions for licensing or click OK to continue. Then the  
main Configuration Manager window displays. You can exit the Configuration Manager. 
 

 

6.  Start the following services: 
Reporter Service 
World Wide Web Publishing Service

7.  From a command window, start the OVIS probes with the following command: 
ovc -start ovprobes 
From a command window, start tomcat with the following command: 
ovc -start ovtomcatA

 

  

Upgrading from MSDE 2000 to Microsoft SQL Express 2005
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If you want to upgrade from MSDE 2000 to SQL Server 2005 Enterprise Edition you will need to first upgrade from 
the default database MSDE 2000 to Microsoft SQL Express 2005. Then you can upgrade from SQL Express 2005 to 
SQL Server 2005 Enterprise Edition. The following section gives and example of an upgrade from MSDE to SQL 
Express 2005.

NOTE: OVIS data is not migrated from the default database to SQL Express 2005.

1.  Begin installing SQL Express 2005 on the system with MSDE (double-click the file SQLEXP2005.exe). You 
can download the software from the Microsoft Download Center. The Microsoft Download Center also 
provides information about the hardware and software requirements and instruction for installing and setting 
up SQL Express 2005.

2.  Complete the license agreement and registration information. Clear the Hide advanced configuration 
options checkbox and click Next. The Feature Selection screen is displayed. 

 
 

 
 

3.  Click Database Services. From the drop-down menu select Entire feature will be installed on local hard 
drive. Click Next.

4.  The Instance Name window appears. The Named Instance should be OVOPS or whatever database you set 
up orginally in MSDE. 
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5.  Click Installed Instances, the Existing Components window appears. Select the Details button to confirm 
that an upgrade is allowed. Click Next.  
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6.  In the Upgrade Logon Information window, select SQL Server Authentication Mode and enter the username 
and password for the SA account. Click Next.  
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7.  In the User Instances windows, select Enable User Instances and click Next.  
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8.  Accept the defaults on the rest of the wizard windows. Click the Install button on the Ready to Install window.  
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9.  The database will now be upgraded from MSDE 2000 to SQL Express 2005.
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  Setup Oracle as the Database 

Internet Services can be configured to work with Oracle as its database. The topics 
below cover several versions of Oracle. 

 IMPORTANT: Note that screen examples and steps may be different than 
documented in the following sections if your operating system or version is different than 
the one used in the example.

 IMPORTANT: An Oracle DBA should be involved in creating the database, 
particularly for configuration issues like database sizing and AUTOEXTEND of datafiles. 

 IMPORTANT: Do not connect multiple copies of Internet Services to the same 
database as unexpected results occur when more than one copy of OVIS attempts to 
write data to the configured  database. 

 IMPORTANT: Migration of data from a different database to a new Oracle database 
is not supported for Internet Services (OVIS). And if OVIS is on the same system as hp 
OpenView Reporter, attempting to migrate data to the new database with Reporter may 
result in problems in OVIS. 

■     UNIX Settings
■     Configure Oracle 9i (HP-UX or Solaris) as the database
■     Configure Oracle 10g (HP-UX or Solaris) as the database
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 UNIX Settings

For Oracle Database Setup on UNIX / Setting UNIX Environment 
Variables  

This document shows settings for a custom database configuration  

Note: Because a successful Oracle configuration is dependent upon correct kernel parameter settings, 
check your HP-UX or Solaris system kernel parameters (see the Oracle  Installation Guide and other 
Oracle documentation for these parameters). Some kernel parameters you may want to look at for HP-
UX include: maxdsiz, maxfiles, maxssiz, maxuprc, nfile, nproc, semmni, semmns, shmmax, shmmni, 
shmseg. And on Solaris you may want to check the following shared memory parameters: 
shminfo_shmmax, shminfo_shmmin, shminfo_shmmni, shminfo_shmseg, seminfo_semmns, 
seminfo_semmni, seminfo_semmsl. Make changes to kernel parameters as needed.  IMPORTANT! To 
activate kernel parameter changes to settings, you must reboot your system. 

  

New Oracle Installations

1.  You must be logged on as root or su
2.  Set UNIX environment variables as follows:

ORACLE_BASE – set to admin pathname default (/opt/oracle) 
ORACLE_SID - set to the database name you want to create (REPORTER)  
ORACLE_HOME - set to full pathname of the Oracle system home directory (for example  /opt/
oracle/product/8.1.7) 
ORACLE_TERM – set to the appropriate value (hpterm, etc…) 
PATH - needs to include $ORACLE_HOME/bin 
UMASK = 022

Existing Oracle Installations

Verify that the following HP-UX environment variables are set:

ORACLE_BASE – set to admin pathname default (/opt/oracle) 
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ORACLE_SID - set to the database name you want to create (REPORTER)  
ORACLE_HOME - set to full pathname of the Oracle system home directory (for example  /opt/
oracle/product/8.1.7)  
ORACLE_TERM – set to the appropriate value (hpterm, etc…) 
PATH - needs to include $ORACLE_HOME/bin
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 Setup Oracle as the Database

Configure Oracle 9i as the Database

Set Up Oracle 9i on HP-UX or Solaris and Configure on Windows

 IMPORTANT: If HP OpenView Internet Services and hp OpenView Reporter are installed on the same 
system, migration of your OVIS/Reporter data from your existing database to Oracle 9i is not supported.

Prerequisites: Because a successful Oracle configuration is dependent upon correct kernel parameter settings, 
check your HP-UX or Solaris system kernel parameters (see the Oracle 9i Installation Guide and other Oracle 
documentation for these parameters). Some kernel parameters you may want to look at for HP-UX include: 
maxdsiz, maxfiles, maxssiz, maxuprc, nfile, nproc, semmni, semmns, shmmax, shmmni, shmseg. And on 
Solaris you may want to check the following shared memory parameters: shminfo_shmmax, shminfo_shmmin, 
shminfo_shmmni, shminfo_shmseg, seminfo_semmns, seminfo_semmni, seminfo_semmsl.

Ensure you have the following available:

●     Memory: 512 MB RAM minimum
●     Swap space: disk space equivalent to the greater of 2*RAM, or at least 512 MB
●     CD-ROM: capable of reading ISO 9660 format with RockRidge extensions
●     Disk space: 3.69 GB for database software; 1 GB for database
●     Temp disk space: 400MB in /tmp directory
●     HP-UX 11.0 (64-bit) or HP-UX 11i (64-bit) 

or 
Solaris 7 (2.7), 8 or 9 

●     Operating system patches (detail in the Oracle9i Release Notes)
●     JAVA components (detailed in the Oracle9i Release Notes)
●     HP-UX note: an important pre-installation step is required relating to X library symbolic links

Oracle Documentation: The documents can be found on the Oracle9i Database CD-ROMs. To access them, 
mount Disk 1 of the Oracle9i Database CD-ROM and open the index.html. Oracle also provides online 
resources for documentation at the Oracle Documentation Center (docs.oracle.com) and the Oracle Technology 
Network (otn.oracle.com/docs/). For Oracle-specific information, please check the following:

●     Oracle9i Installation Guide
●     Oracle9i Quick Installation Procedure
●     Oracle9i Release Notes

 IMPORTANT: If you use systems with different language settings, the OVIS Reporter database should be 
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created using the same default locale character set as the system where OVIS is installed (Management 
Server). At this time, OVIS does not support databases that have been configured to use the UTF-8 character 
set.

Database Performance Note:

Adding indexes can improve performance. With OVIS 5.2 indexes were added to the following tables. Consult 
your DBA for a maintenance plan for these indexes.

IOPS_PROBE_DATA

Index Field

Indx2_IOPS_PROBE_DATA DATETIME

Indx6_IOPS_PROBE_DATA CUSTOMER_NAME

Indx7_IOPS_PROBE_DATA SERVICE_NAME

Indx25_IOPS_PROBE_DATA PROBENAME

IOPS_PROBE_DATA_CACHE

Index Field

Indx2_IOPS_PROBE_DATA_CACHE DATETIME

Indx6_IOPS_PROBE_DATA_CACHE CUSTOMER_NAME

Indx7_IOPS_PROBE_DATA_CACHE SERVICE_NAME

Indx25_IOPS_PROBE_DATA_CACHE PROBENAME

IOPS_PROBE_DATA_DAILY

Index Field

Indx2_IOPS_PROBE_DATA_DAILY DATETIME

Indx6_IOPS_PROBE_DATA_DAILY CUSTOMER_NAME

Indx7_IOPS_PROBE_DATA_DAILY SERVICE_NAME

Indx25_IOPS_PROBE_DATA_DAILY PROBENAME

IOPS_DETAIL_DATA

Index Field

Indx5_IOPS_DETAIL_DATA DATETIME

Indx7_IOPS_DETAIL_DATA PROBENAME

Indx8_IOPS_DETAIL_DATA CUSTOMER

Indx11_IOPS_DETAIL_DATA SERVICENAME
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IOPS_DETAIL_DATA_HOURLY

Index Field

Indx5_IOPS_DETAIL_DATA_HOURLY DATETIME

Indx7_IOPS_DETAIL_DATA_HOURLY PROBENAME

Indx8_IOPS_DETAIL_DATA_HOURLY CUSTOMER

Indx11_IOPS_DETAIL_DATA_HOURLY SERVICENAME

IOPS_DETAIL_DATA_DAILY

Index Field

Indx5_IOPS_DETAIL_DATA_DAILY DATETIME

Indx7_IOPS_DETAIL_DATA_DAILY PROBENAME

Indx8_IOPS_DETAIL_DATA_DAILY CUSTOMER

Indx11_IOPS_DETAIL_DATA_DAILY SERVICENAME

 

Configuration steps are divided into two sets of tasks as follows:

Server setup for Oracle9i on HP-UX or Solaris system:

●     Prepare the UNIX environment
●     Mount the installation CD
●     Install Oracle9i Database Server software
●     Configure a database listener
●     Create the Reporter database structure
●     Create the Reporter database user and privileges

Client setup for Oracle9i on Windows OVIS system:

●     Install Oacle9i client software
●     Configure the Oracle Net connection
●     Verify the Oracle Net connection
●     Configure the ODBC data source
●     Configure the database in OVIS

Server Set Up for Oracle 9i on HP-UX or Solaris

Task 1  Prepare the UNIX Environment
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1.  Create the Oracle UNIX groups: 
HP-UX: use the System Administrator's Manager (SAM) to create groups 
Solaris: use the admintool or groupadd utility to create groups 
 
a. Log in as the root user. 
b. Create UNIX group "dba" (The OSDBA group) 
c. Create UNIX group "oper" (The OSOPER group) 
d. Create UNIX group "oinstall" (The ORAINVENTORY group) 
HP-UX note: See the Oracle9i Quick Installation Procedure for the special privileges that should be 
assigned to the OSDBA group. 

2.  Create the UNIX user "oracle": 
HP-UX: use the System Administrator's Manager (SAM) to create accounts 
Solaris: use the admintool or useradd utility to create accounts. 
 
Create UNIX user "oracle" (This account is for Oracle software installation and upgrading only) 
   — Primary group: oinstall (The ORAINVENTORY group) 
   — Secondary group: dba (The OSDBA group) 

      An example on HP-UX of creating a secondary user: In SAM go to the dba group and add 
      oracle as a user. 

Create UNIX user "apache" 
   — Primary group: oinstall (The ORAINVENTORY group) 
   — Secondary group: group in which apache is only member. 
       Do this by creating an apache group and add apache as the only user. The Apache  
       account should have minimum privileges.

3.  Create mount points for Oracle database software 
a. Enter: cd /opt 
b. Enter: chown -R oracle:oinstall oracle 
 
c. Make sure a local bin directory such as /usr/local/bin or /opt/bin exists. 
 
d. Set UNIX system and Oracle environment variables 
   (add to .profile or set manually) 
 
   DISPLAY=<workstation_name>:0.0 (where you want output from Oracle installer displayed) 
   ORACLE_BASE=/opt/oracle 
   ORACLE_HOME=/opt/oracle/product/9.2 
   ORACLE_SID=reporter 
   PATH includes $ORACLE_HOME/bin, /usr/ccs/bin, /usr/bin, /etc, (/usr/bin/X11 
   for HP-UX), (/usr/openwin/bin for Solaris), and /usr/local/bin (if it exists) 
 
Example of .profile for HP-UX: 
 
   # Oracle Environment 
   ORACLE_BASE=/opt/oracle; export ORACLE_BASE 
   ORACLE_HOME=/opt/oracle/product/9.2; export ORACLE_HOME 
   ORACLE_SID=reporter; export ORACLE_SID 
   ORACLE_TERM=xterm; export ORACLE_TERM 
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   TNS_ADMIN=/export/home/oracle/config/9.2; export TNS_ADMIN 
   NLS_LANG=AMERICAN_AMERICA.UTF8; export NLS_LANG 
   ORA_NLS33=$ORACLE_HOME/ocommon/nls/admin/data; export ORA_NLS33 
   LD_LIBRARY_PATH=$ORACLE_HOME/lib:/lib:/usr/lib:$ORACLE_HOME/rdbms/lib 
   SHLIB_PATH=$ORACLE_HOME/lib32:$ORACLE_HOME/rdbms/lib32 
   export LD_LIBRARY_PATH 
   export SHLIB_PATH 
 
   #set shell search paths 
   PATH=/bin:/usr/bin:/usr/sbin:/etc:/opt/bin:/usr/ccs/bin:/usr/local/bin:$ORACLE_HOME/bin 
   export PATH 
 
   #CLASSPATH must include the following JRE locations: 
   CLASSPATH=$ORACLE_HOME/JRE:$ORACLE_HOME/jlib:$ORACLE_HOME/rdbms/jlib 
   CLASSPATH=$CLASSPATH:$ORACLE_HOME/network/jlib 

Task 2  Mount the Installation CD

    For HP-UX:

1.  Edit the /etc/pfs_fstab file to add the following: 
 
<device_file> <mount_point> <filesystem_type> <translation_method> 
 
Definitions of the above syntax:

●     <device_file> = CD-ROM device file (discover with ioscan -nFC disk)
●     <mount_point> = path name of the mount point
●     <filesystem_type> = CD-ROM is in IS09660 format, Rockridge extension
●      <translation_method> = unix 

For example: 
/dev/dsk/c1t2d0 /CDROM pfs-rrip xlat=unix 0 0

2.  Perform the following steps as the root user:

Enter: /usr/sbin/pfs_mountd & (Note:pfs creates the correct format to read the CD) 
Enter: /usr/sbin/pfsd & 

3.  Insert the CD into the CD-ROM and mount the device as follows: 
/usr/sbin/pfs_mount /CDROM

Leave the root user window available for executing a script during installation .

For Solaris: 
If you are using Volume Management software (available by default on Solaris) the CD-ROM is mounted 
automatically to /cdrom/orcl901_1 when you put it into the disk drive. 
If you are not using the Volume Management software, you must mount the CD-ROM manually.

1.  Place the Oracle 9i CD-ROM in the CD-ROM drive.
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2.  Log in as the root or su user and create a CD-ROM mount point directory: 
$ su root 
# mkdir cdrom_mount_point_directory

3.  Mount the CD-ROM drive on the mount point directory and exit: 
# mount option device_name cdrom_mount_point_directory 
# exit

Task 3  Install Oracle 9i Database Server Software

1.  Log in to the Oracle account.
2.  Launch the Oracle Universal Installer by typing the full path to the installer executable.   

 Warning don't launch the installer from within the CDROM directory or you won't be able to mount 
multiple CDs. 
Example: 
 /cdrom/oracle9i/runInstaller or /CDROM/runInstaller.

3.  For first-time Oracle9i installations the Welcome window appears, where you click Next.
4.  In the File Locations window do not change the text in the source field and click Next.
5.  In the Inventory Location window enter ORACLE HOME directory name and path and click Next.
6.  You may have to run a script if pre-installation tasks were not completed.
7.  In the Available Products window select Oracle9i Database (version 9.2.0.1.0 was used for these 

instructions and screen shots) and click Next.
8.  In the Installation Types window select Enterprise Edition. 

(Alternatively you can select the Standard Edition; see Oracle documentation for differences between 
these installation types.) Click Next.

9.  In the Database Configuration Window select Software Only and click Next.
10.  In the Choose JDK Home Directory Window enter the appropriate location and click Next.
11.  Review the Summary Window and click Install. 

(When the Install window appears, wait as the product is installed.)
12.  When the Setup Privileges window appears, run the script if instructed.
13.  In the End of Installation window select Exit.

Task 4  Configure a database listener

1.  At a UNIX console window, log in as the Oracle user, enter netca to start the Oracle Net Configuration 
Assistant. 

2.  In the Welcome window select Listener configuration and click Next. 
3.  Select Add and click Next. 
4.  Enter a listener name (LISTENER is suggested) and click Next. 
5.  For the connection protocol select TCP and click Next. 
6.  Select the standard port number 1521 and click Next. 
7.  For configuring another listener, select No. 
8.  At the configuration complete message click Next. 
9.  In the final window click Finish.
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Task 5  Create the Reporter database structure

1.  At a UNIX console window, log in as the Oracle user, enter dbca to start the Oracle Database 
Configuration Assistant. 
 

2.  Select the Create a Database option and click Next. 
 Important: These procedures and screen examples are for Oracle 9.2.0.1.0 on HP-UX.   

Other operating systems and versions may be different. 

 
 

3.  Select the New Database template and click Next. 
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4.  Supply Global Database Name and the SID and click Next. 

 
 

5.  You can optionally de-select the  listed features, which are not required for the Reporter database, and 
click Next. 
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6.  Select the Dedicated Server Mode click Next. 

 
 

7.  In the Memory tab, select Typical.  Accept the default value for Percentage of physical memory (or as 
directed by your DBA) and then select the Archive tab. 
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8.  (optional) Select the Archive tab and the Archive Log Mode if you want a back up strategy that ensures 
data recoverability that goes beyond the most recent backup. 
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9.  Select the DB Sizing tab and set the Block Size to 8K. 
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10.  Select the File Locations tab, where you can review the location settings, and click Next. 

file:///C|/hpovreports/Help/Concepts_Guide/section04H.htm (12 of 22)3/16/2007 11:25:21 AM

Page 59



 Configure Oracle 9i (HP-UX or Solaris) as the Database

 
 

11.  In the Database Storage window click the Tablespaces entry in the tree to view current tablespace 
configuration. 
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12.  Click the Add button to add the REPORTER tablespace. Size the tablespace to 600MB.

 Important: In the next two steps, if the actual storage size of 600MB for REPORTER 
tablespace and 300MB for the RPT_INDEXES tablespace is not large enough, please consult 
your Oracle DBA on the appropriate size for your environment or how to setup the 
AUTOEXTEND datafile feature in Oracle. 
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13.  Select the Storage tab, verify Locally Managed extents with Automatic Allocation, and click Create.
14.  Click the Add button to add the RPT_INDEXES tablespace, size the tablespace to 300MB.
15.  Select the Storage tab, verify Locally Managed extents with Automatic Allocation, and click Create. 
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16.  Click the Tablespaces entry in the tree to verify that the REPORTER and RPT_INDEXES tablespaces 
have been added to the configuration, and click Next.

17.  Select the Create Database option. (Optionally, you can save scripts for this DB creation process and 
execute them later.) Click Finish.

18.  When the Database Creation progress window appears, several hours may be required to create the 
database depending upon the options that are selected. Respond to the database creation completion 
messages and close the Database Configuration Assistant. 
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19.  (Optional) Verify the availability of the REPORTER database. 
A. At a UNIX console window, log in as the Oracle user, and start the SQL *Plus environment by 
    entering: sqlplus 
B. Supply the user-name and password (for example, system / manager should be available as a user-
name and password on this newly created database). 
C. At the SQL prompt enter column tablespace_name format a40;. 
D. Enter select tablespace_name, status from user_tablespaces; 
E. Verify that the expected tablespaces are available and enter exit to leave SQL *Plus. 
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Task 6 Create the Reporter database user and privileges

1. Start the SQL *Plus environment as described above.

2. Execute the following SQL statements to create the user for the REPORTER database:

create user openview profile default 
identified by openview 
default tablespace reporter 
temporary tablespace temp 
quota unlimited on reporter 
quota unlimited on rpt_indexes 
account unlock; 
grant 
create any index, 
create procedure, 
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create sequence, 
create session, 
create table, 
create trigger, 
create view, 
unlimited tablespace, 
connect to openview;

Configure Oracle Client Software on the Windows System

This section covers the installation of the software that allows the Windows system, on which OVIS runs, to 
connect to the HP-UX or Solaris system, from which the Oracle database is accessed.

Task 1  Install Oracle 9i Client software

1.  At the OVIS Management Server Windows system, insert the Oracle9i installation CD and in the window 
that appears select Install/Deinstall Products .

2.  In the Oracle Universal Installer Welcome window click Next.
3.  Enter or select an Oracle 9 home location for this installation and click Next.
4.  In the Available Products window select Oracle9i Client and click Next.
5.  In the Installation Types window select Administrator and click Next.
6.  Verify the information in the Summary window and click Install.

A window showing installation progress will appear. The installation process also starts the Oracle Net 
Configuration Assistant tool. Proceed to Task 2 for completion of this activity.

Task 2 Configure the Oracle Net connection

The Oracle Net Configuration Assistant tool can be started independently (without re-installing client software) 
by selecting Start -> Programs -> Oracle-OraHome9 -> Configuration and Migration Tools -> Net 
Configuration Assistant. The first few dialogs differ between an installation-initiated Assistant compared with 
an independently started Assistant. The steps below use the dialogs encountered when the Assistant is started 
as part of the client installation.

1.  In the Welcome window select No, I will create net service names myself., and click Next.
2.  In the Database Version window select Oracle8i or later and click Next.
3.  In the Service Name window supply the service name for the database (typically reporter or reporter.

<domain>, the global database name), and click Next.
4.  In the Select Protocols window choose the appropriate network protocol (typically TCP), and click Next.
5.  In the TCP/IP Protocol window, supply the Host name and port number (typically 1521), click Next.
6.  In the Test window, select Yes, and click Next.
7.  In the Connecting window verify that the connection was successful; you may have to change the login 

credentials (openview/openview) for the test to succeed.
8.  Click Next.
9.  In the Net Service Name window supply a service name (suggested: RPT), and click Next.

10.  In the Another Net Service Name window select No, and click Next.
11.  In the Done window click Next and then Finish.
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Task 3 Verify the Oracle Net connection

After completion of the Oracle Net Configuration, perform the following steps to verify that you can connect to 
the Reporter database from your Windows system.

1.  Start the SQL *Plus tool by selecting Start -> Programs -> Oracle-OraHome9 -> Application 
Development -> SQL Plus.

2.  At the Log On dialog supply the User Name (system), Password (manager), and Host String (RPT), [the 
Net Service Name supplied in Task 2, step 9].

3.  Enter the following SQL statement: select tablespace_name, status from user_tablespaces;

You should see results similar to the following:

If you cannot connect to the database, or do not see these tablespaces, check with the Oracle database 
administrator for the UNIX host system.

4.  To leave the SQL *Plus environment, type Exit. 

Task 4  Configure the ODBC data source
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1.  Stop the following services: 
Reporter Service 
World Wide Web Publishing Service

2.  From a command window, stop the OVIS probes with the following command: 
ovc -stop ovprobes 
From a command window, stop tomcat with the following command: 
ovc -stop ovtomcatA

3.  To launch the Windows Control Panel, select Start -> Settings -> Control Panel.
4.  Double-click Administrative Tools, then double-click Data Sources (ODBC).
5.  In the ODBC Data Source Administrator, select the System DSN tab.
6.  If it exists, select the Reporter DSN and remove it.
7.  Select the Add… button and highlight the Oracle in OraHome9 driver and click Finish.
8.  In the Oracle ODBC Driver Configuration window enter Reporter as the Data Source name.

 Important: You must enter Reporter as the Data Source Name in mixed case (uppercase "R") 
to match references to it in Internet Services executables.

For the TNS Service Name, from the drop-down menu select the name configured in 
Task 2, step 9 (RPT).

Select the Oracle tab and set Prefetch Count to 25 and disable LOBs. 

 

7.  To test the connection (if desired), click Test Connection and supply the username and password 
(openview/openview).

8.  To add this data source to the System DSNs, click OK.
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Task 5  Configure the Database in OVIS

1.  To start  Internet Services Configuration Manager, select  
Start>Programs>HP OpenView>internet services>Configuration Manager.

2.  An error message is expected; click Yes or OK to proceed.  Then database login may be required, if 
so see the next step, proceed to step 5.  

3.  In the Database Login dialog box, enter the database User Name and Password that you used for the  
UNIX system configuration in Task 6 (username: openview; password: openview). 

 
4.  Click OK 
5.  You will see the  Internet Services Startup status bars. Then the Configure License dialog 

may be displayed.  Follow the instructions for licensing or click OK to continue. Then the  
main Configuration Manager window displays. You can exit the Configuration Manager. 

 
6.  Restart IIS as follows. Note that restarting IIS will also restart World Wide Web Publishing Service so you 

don't have to start that in the next step.  
Go into the Control Panel and select Administrative Tools > Internet Services Manager. Right-click on 
the machine name and choose Restart IIS...

7.  Start the following services: 
Reporter Service 
World Wide Web Publishing Service

8.  From a command window, start the OVIS probes with the following command: 
ovc -start ovprobes 
From a command window, start tomcat with the following command: 
ovc -start ovtomcatA
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 Setup Oracle as the Database

Configure Oracle 10g as the Database

Set Up Oracle 10g on HP-UX or Solaris and Configure the Client on Windows

 IMPORTANT: If HP OpenView Internet Services and hp OpenView Reporter are installed on the same system, migration of 
your OVIS/Reporter data from your existing database to Oracle is not supported.

Prerequisites: Because a successful Oracle configuration is dependent upon correct kernel parameter settings, check your HP-
UX or Solaris system kernel parameters (see the Oracle Installation Guide and other Oracle documentation for these 
parameters). 

Ensure you have the following available:

●     Memory: 512 MB RAM minimum
●     Swap space: disk space equivalent to the greater of 2*RAM, or at least 1 GB
●     CD-ROM: capable of reading ISO 9660 format with RockRidge extensions
●     Disk space: 3.69 GB for database software; 1 GB for database
●     Temp disk space: 400MB in /tmp directory
●     Solaris (Sun SPARC) and HP-UX (PARISC) - refer to the Oracle documentation for Oracle 10g server support on 

specific operating system versions
●     Operating System patches (detailed in the Oracle10g Release Notes)
●     JAVA components (detailed in the Oracle10g Release Notes)
●     HP-UX note: an important pre-installation step is required relating to X library symbolic links

Oracle Documentation: The documents can be found on the Oracle10g Database CD-ROMs. To access them, mount Disk 1 
of the Oracle10g Database CD-ROM and open the index.html. Oracle also provides online resources for documentation at the 
Oracle Documentation Center and the Oracle Technology Network (http://www.oracle.com/technology/documentation/index.
html). For Oracle-specific information, please check the following:

●     Oracle10g Installation Guide
●     Oracle10g Quick Installation Procedure
●     Oracle10g Release Notes

 IMPORTANT: If you use systems with different language settings, the OVIS Reporter database should be created using the 
same default locale character set as the system where OVIS is installed (Management Server). At this time, OVIS does not 
support databases that have been configured to use the UTF-8 character set.

 

Database Performance Note:

Adding indexes can improve performance. Indexes are provided in the following tables. Consult your DBA for a maintenance 
plan for these indexes.
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IOPS_PROBE_DATA

Index Field

Indx2_IOPS_PROBE_DATA DATETIME

Indx6_IOPS_PROBE_DATA CUSTOMER_NAME

Indx7_IOPS_PROBE_DATA SERVICE_NAME

Indx25_IOPS_PROBE_DATA PROBENAME

IOPS_PROBE_DATA_CACHE

Index Field

Indx2_IOPS_PROBE_DATA_CACHE DATETIME

Indx6_IOPS_PROBE_DATA_CACHE CUSTOMER_NAME

Indx7_IOPS_PROBE_DATA_CACHE SERVICE_NAME

Indx25_IOPS_PROBE_DATA_CACHE PROBENAME

IOPS_PROBE_DATA_DAILY

Index Field

Indx2_IOPS_PROBE_DATA_DAILY DATETIME

Indx6_IOPS_PROBE_DATA_DAILY CUSTOMER_NAME

Indx7_IOPS_PROBE_DATA_DAILY SERVICE_NAME

Indx25_IOPS_PROBE_DATA_DAILY PROBENAME

IOPS_DETAIL_DATA

Index Field

Indx5_IOPS_DETAIL_DATA DATETIME

Indx7_IOPS_DETAIL_DATA PROBENAME

Indx8_IOPS_DETAIL_DATA CUSTOMER

Indx11_IOPS_DETAIL_DATA SERVICENAME

IOPS_DETAIL_DATA_HOURLY

Index Field

Indx5_IOPS_DETAIL_DATA_HOURLY DATETIME

Indx7_IOPS_DETAIL_DATA_HOURLY PROBENAME

Indx8_IOPS_DETAIL_DATA_HOURLY CUSTOMER

Indx11_IOPS_DETAIL_DATA_HOURLY SERVICENAME

IOPS_DETAIL_DATA_DAILY
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Index Field

Indx5_IOPS_DETAIL_DATA_DAILY DATETIME

Indx7_IOPS_DETAIL_DATA_DAILY PROBENAME

Indx8_IOPS_DETAIL_DATA_DAILY CUSTOMER

Indx11_IOPS_DETAIL_DATA_DAILY SERVICENAME

 

 

Configuration steps are divided into two sets of tasks as follows:

Server setup for Oracle10g on HP-UX or Solaris system:

●     Prepare the UNIX environment
●     Mount the installation CD
●     Install Oracle10g Database Server software
●     Configure a database listener
●     Create the Reporter database structure
●     Create the Reporter database user and privileges

Client setup for Oracle10g on Windows OVIS system:

●     Install Oacle10g client software
●     Configure the Oracle Net connection
●     Verify the Oracle Net connection
●     Configure the ODBC data source
●     Configure the database in OVIS

 

Server Set Up for Oracle 10g on HP-UX or Solaris

 

Task 1  Prepare the UNIX Environment

1.  Create the Oracle UNIX groups: 
HP-UX: use the System Administrator's Manager (SAM) to create groups 
Solaris: use the admintool or groupadd utility to create groups 
 
a. Log in as the root user. 
b. Create UNIX group "dba" (The OSDBA group) 
c. Create UNIX group "oinstall" (The ORAINVENTORY group) 
HP-UX note: See the Oracle10g Quick Installation Procedure for the special privileges that should be assigned to the 
OSDBA group. 

2.  Create the UNIX user "oracle": 
HP-UX: use the System Administrator's Manager (SAM) to create accounts 
Solaris: use the admintool or useradd utility to create accounts. 
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Create UNIX user "oracle" (This account is for Oracle software installation and upgrading only) 
   — Primary group: oinstall (The ORAINVENTORY group) 
   — Secondary group: dba (The OSDBA group) 

     

3.  a. Create mount points for Oracle database software  
    (for example cd /opt and enter: chown -R oracle:oinstall oracle) 
 
b. Set the right permissions for the Oracle user by running chmod -R 755 for the installation directory  
     (for example /opt/oracle). 
 
c. Make sure a local bin directory such as /usr/local/bin or /opt/bin exists. 
 
d. Set UNIX system and Oracle environment variables 
   (add to .profile or set manually) 
 
   DISPLAY=<workstation_name>:0.0 (where you want output from Oracle installer displayed) 
   ORACLE_BASE=/opt/oracle 
   ORACLE_HOME=/opt/oracle/product 
   ORACLE_SID=reporter 
   PATH includes $ORACLE_HOME/bin, /usr/ccs/bin, /usr/bin, /etc, (/usr/bin/X11 
   for HP-UX), (/usr/openwin/bin for Solaris), and /usr/local/bin (if it exists) 
 
Example of .profile for HP-UX: 
 
   # Oracle Environment 
   ORACLE_BASE=/opt/oracle; export ORACLE_BASE 
   ORACLE_HOME=/opt/oracle/product; export ORACLE_HOME 
   ORACLE_SID=reporter; export ORACLE_SID 
   ORACLE_TERM=xterm; export ORACLE_TERM 
   NLS_LANG=AMERICAN_AMERICA.UTF8; export NLS_LANG 
   ORA_NLS33=$ORACLE_HOME/ocommon/nls/admin/data; export ORA_NLS33 
   LD_LIBRARY_PATH=$ORACLE_HOME/lib:/lib:/usr/lib:$ORACLE_HOME/rdbms/lib 
   SHLIB_PATH=$ORACLE_HOME/lib32:$ORACLE_HOME/rdbms/lib32 
   export LD_LIBRARY_PATH 
   export SHLIB_PATH 
 
   #set shell search paths 
   PATH=/bin:/usr/bin:/usr/sbin:/etc:/opt/bin:/usr/ccs/bin:/usr/local/bin:$ORACLE_HOME/bin 
   export PATH 
 
   #CLASSPATH must include the following JRE locations: 
   CLASSPATH=$ORACLE_HOME/JRE:$ORACLE_HOME/jlib:$ORACLE_HOME/rdbms/jlib 
   CLASSPATH=$CLASSPATH:$ORACLE_HOME/network/jlib

 

Task 2  Mount the Installation CD

    For HP-UX:

1.  Edit the /etc/pfs_fstab file to add the following: 
 
<device_file> <mount_point> <filesystem_type> <translation_method> 
 
Definitions of the above syntax:
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●     <device_file> = CD-ROM device file (discover with ioscan -nFC disk)
●     <mount_point> = path name of the mount point
●     <filesystem_type> = CD-ROM is in IS09660 format, Rockridge extension
●      <translation_method> = unix 

For example: 
/dev/dsk/c1t2d0 /CDROM pfs-rrip xlat=unix 0 0

2.  Perform the following steps as the root user:

Enter: /usr/sbin/pfs_mountd & (Note:pfs creates the correct format to read the CD) 
Enter: /usr/sbin/pfsd & 

3.  Insert the CD into the CD-ROM and mount the device as follows: 
/usr/sbin/pfs_mount /CDROM

Leave the root user window available for executing a script during installation .

For Solaris: 
If you are using Volume Management software (available by default on Solaris) the CD-ROM is mounted automatically when 
you put it into the disk drive. 
If you are not using the Volume Management software, you must mount the CD-ROM manually.

1.  Place the Oracle CD-ROM in the CD-ROM drive.
2.  Log in as the root or su user and create a CD-ROM mount point directory: 

$ su root 
# mkdir cdrom_mount_point_directory

3.  Mount the CD-ROM drive on the mount point directory and exit: 
# mount option device_name cdrom_mount_point_directory 
# exit

 

Task 3  Install Oracle 10g Database Server Software

1.  Log in to the Oracle account.
2.  Launch the Oracle Universal Installer by typing the full path to the installer executable.   

 Warning don't launch the installer from within the CDROM directory or you won't be able to mount multiple CDs. 
Example: 
 /cdrom/oracle10g/runInstaller or /CDROM/runInstaller.

3.  For first-time Oracle10g installations the Welcome window appears, where you click Next.
4.  In the File Locations window do not change the text in the source field and click Next.
5.  In the Inventory Location window enter ORACLE HOME directory name and path and click Next.
6.  You may have to run a script if pre-installation tasks were not completed.
7.  In the Available Products window select Oracle10g Database and click Next.
8.  Select the type of installation you are doing.  You can select Enterprise or Standard Edition (see Oracle documentation 

for differences between these installation types) or Custom.  (Note that if you select a Custom Installation you must at 
least select the following items: Oracle, Oracle Net Services, and all the subproducts on Oracle Net Services.)  Click 
Next.

9.  View the product specific prerequisite check.  Click Next.
10.  In the Database Configuration Window select Do not create a starter database.  Then click Next.
11.  Review the Summary Window and click Install. 

(When the Install window appears, wait as the product is installed.)
12.  When the Setup Privileges window appears, run the script if instructed.
13.  In the End of Installation window select Exit.
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Task 4  Configure a database listener

1.  At a UNIX console window, log in as the Oracle user, enter netca to start the Oracle Net Configuration Assistant. 
2.  In the Welcome window select Listener configuration and click Next. 
3.  Select Add and click Next. 
4.  Enter a listener name (LISTENER is suggested) and click Next. 
5.  For the connection protocol select TCP and click Next. 
6.  Select the standard port number 1521 and click Next. 
7.  For configuring another listener, select No. 
8.  At the configuration complete message click Next. 
9.  In the final window click Finish.

 

Task 4.5  Before creating the database, be sure you have patched up to Oracle version 10.1.0.4 or higher.  

 

 

 

Task 5  Create the Reporter database structure

1.  At a UNIX console window, log in as the Oracle user, enter dbca.  The Oracle Database Configuration Assistant 
Welcome page is displayed. Click on Next.  
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2.  Select the Create a Database option and click Next. 

3.  Select the Custom Database template and click Next. 
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4.  Enter Global Database Name as Reporter and enter the SID as reporter. Click on Next. 

5.  You may see the following screen, choose the option as appropriate, you can leave it to default. Click on Next.  
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6.  Give the Password and Confirm Password (openview openview or whatever you choose). Click on Next.  

7.  You may see the following screen displayed, select the first option (File System) and click on Next. 
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8.  In the following screen, select Use Common Location for ALL Database Files and enter the path for database files to 
be created.   
You may optionally browse to locate the directory (the screen shot is just an example).  Click Next to continue. 

9.  Click on Next.  
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10.  Click on Next. 

11.  Select Typical installation option on the following screen and accept the default value for Percentage of physical memory 
or you can change the percentage as directed by your database administrator.  The Percentage you see may be different 
than in the screen shot below. 
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12.  Select the Sizing tab and verify the Block Size and Processes. 

13.  Select the Character Sets tab and verify the following as shown in the screen shot. (Use the default is selected). 
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14.  Select the Connection Mode tab and choose Dedicated Server Mode.  

15.  Click on Next. and the following screen is displayed. 
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16.  Select Tablespaces in the left pane. Click on the Create button.  

 
 

17.  You will get a window for creating the tablespace. Add the REPORTER tablespace (file name reporter.dpf) and set the 
size as 600MB. 
Enter 600MB as the data storage space by editing the size column. 

 Important: If the actual storage size of 600MB for REPORTER tablespace and 300MB for the RPT_INDEXES 
tablespace is not large enough, please consult your Oracle DBA on the appropriate size for your environment or how to 
setup the AUTOEXTEND datafile feature in Oracle. 
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18.  In the same window select the Storage tab and be sure selections are as shown.  
Then click on Create to create the datafile. 
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19.  After the creation of REPORTER tablespace, click on Tablespaces and use the Create button again to create a new 
tablespace called RPT_INDEXES (filename rpt_indexes.dbf)  with the same parameters and DB size of 300MB (see the 
steps above).   
Then click on Next.

20.  In the screen shown below, use the default Create Database (Optionally, you can save scripts for this DB creation 
process and execute them later).  
Click on the Finish button.     

 
 

21.  Then in the Confirmation Window click OK.  
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22.  You will then see the Database Configuration Assistant window. 
Several hours may be required to create the database depending upon the options that are selected.  
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After the database has been created, you will see the Database creation complete message. 
Respond to the database creation completion messages and close the Database Configuration Assistant. 
 
 

Task 6 Create the Reporter database user and privileges

1. Start the SQL *Plus environment as described below:

A. At a UNIX console window, log in as the Oracle user, and start the SQL *Plus environment by 
    entering: sqlplus 
B. Supply the user-name and password (for example, system / administrator should be available on this newly 
created database).

2. Execute the following SQL statements to create the user for the REPORTER database:

create user openview profile default 
identified by openview 
default tablespace reporter 
temporary tablespace temp 
quota unlimited on reporter 
quota unlimited on rpt_indexes 
account unlock;

You will see the 'user created' message. Execute the statements below to grant permissions.

grant 
create any index, 
create procedure, 
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create sequence, 
create session, 
create table, 
create trigger, 
create view, 
unlimited tablespace, 
connect to openview;

Configure Oracle Client Software on the Windows System

This section covers the installation of the software that allows the Windows system, on which OVIS runs, to connect to the HP-
UX or Solaris system, from which the Oracle database is accessed.

Task 1  Install Oracle 10g Client software

1.  At the OVIS Management Server Windows system, insert the Oracle10g client installation CD. Select Install/Deinstall 
Products.

2.  In the Oracle Universal Installer Welcome window click Next.
3.  Enter or select an Oracle home location for this installation and click Next.
4.  In the Available Products window select Oracle10g Client and click Next.
5.  In the Installation Types window select Administrator and click Next.
6.  Verify the information in the Summary window and click Install.

A window showing installation progress will appear. The installation process may also start the Oracle Net Manager tool. 
Proceed to Task 2 for completion of this activity.

Task 2 Configure the Oracle Net connection

After installing the Oracle 10g client software you configure the client.  The following instructions are using the Oracle Net 
Manager tool (you may also use the Oracle Net Configuration Assistant for configuring the client).

1.  The Oracle Net Manager tool can be started independently (without re-installing client software) by selecting Start > 
Programs > Oracle-OraClient10g_home > Configuration and Migration Tools > Net Manager. 
 
 

2.  This opens the Oracle Net Manager as shown below. In this screen, click on the + sign to invoke the Net Service Name 
Wizard. 
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3.  In the Net Service Name Wizard, enter Net Service Name = REPORTER or whatever was the service name given 
during the Reporter database configuration. Then click on the Next button. 
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4.  In the Net Service Name Wizard, page 2 or 5; select the protocol TCP/IP (Internet Protocol). Then click Next. 

 
 

5.  In the Net Service Name Wizard, page 3 of 5; enter the Host Name. The name should be the fully qualified domain 
name of the machine where the Oracle server is installed.  
 
In the same screen, enter the Port number for the Oracle database. The default port for Oracle databases is 1521.  Then 
click Next. 
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6.  In the Net Service Name Wizard, page 4 of 5; select (Oracle 8i or later) Service Name and enter REPORTER (or 
whatever was given as the Service Name while installing the Oracle database server). Click Next. 

 
 

7.  In the Connection Test screen, click on the Test button. This test may fail because the username and password is set to 
the Oracle default and does not match the Reporter database username and password. 
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8.  If the test failed, select the Change Login button and enter openview/openview as Username and Password (or the 
username and password given during the database server installation). Then click the OK button. 
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9.  Select Test again. You should see the successful message. This is the checkpoint that the Oracle client is successfully 
connecting to the Oracle Server.   
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10.  Click on Close to close the Connection Test Wizard and return to the Oracle Net Manager screen. 
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11.  In the Oracle Net Manager screen, save the configuration by selecting File > Save Network Configuration. 
Then select File > Exit to exit the Oracle Net Manager wizard. 
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Task 3 Verify the Oracle Net connection

After completion of the Oracle Net Configuration, perform the following steps to verify that you can connect to the Reporter 
database from your Windows system.

1.  Start the SQL *Plus tool by selecting Start -> Programs -> Oracle-OraClient10g_Home -> Application Development -
> SQL Plus.

2.  At the Log On dialog supply the User Name (openview or whatever you set up), Password (openview or whatever you 
set up), and Host String (REPORTER), [the Net Service Name supplied earlier].

3.  Enter the following SQL statement: select tablespace_name, status from user_tablespaces;

If you cannot connect to the database, or do not see these tablespaces, check with the Oracle database administrator for the 
UNIX host system.

4.  To leave the SQL *Plus environment, type Exit. 

 

Task 4  Configure the ODBC data source

1.  Stop the following services: 
Reporter Service 
World Wide Web Publishing Service

2.  From a command window, stop the OVIS probes with the following command: 
ovc -stop ovprobes 
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From a command window, stop tomcat with the following command: 
ovc -stop ovtomcatA

3.  To launch the Windows Control Panel, select Start -> Settings -> Control Panel.
4.  Double-click Administrative Tools, then double-click Data Sources (ODBC).
5.  In the ODBC Data Source Administrator, select the System DSN tab.
6.  If it exists, select the Reporter DSN and remove it.
7.  Select the Add… button and highlight the Oracle driver and click Finish.
8.  In the Oracle ODBC Driver Configuration window enter Reporter as the Data Source name.

 Important: You must enter Reporter as the Data Source Name in mixed case (uppercase "R") to match 
references to it in Internet Services executables.

For the TNS Service Name, from the drop-down menu select the name configured earlier (REPORTER).

Select the Oracle tab and set Prefetch Count to 25 and disable LOBs. 
 

 

7.  To test the connection (if desired), click Test Connection and supply the username and password (openview/openview 
or whatever you used in the initial set up) and click OK.

8.  To add this data source to the System DSNs, click OK.

 

Task 5  Configure the Database in OVIS

1.  To start  Internet Services Configuration Manager, select  
Start>Programs>HP OpenView>internet services>Configuration Manager.

2.  If you see an error; click Yes or OK to proceed.  Then database login may be required, if 
so see the next step, otherwise go on to step 5.  

3.  In the Database Login dialog box, enter the database User Name and Password that you used for the  
UNIX system configuration (username: openview; password: openview). 
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4.  Click OK 
5.  You may see various  Internet Services Startup status bars. Continue on to the  

main Configuration Manager window. You can exit the Configuration Manager. 
6.  Reboot the management server system.

If you see this error when closing or saving in the Configuration Manager:

You need to set permissions on several users as follows:

1.  Select the Oracle Client directory (for example: c:\oracle\product\10.1.0\Client_1)
2.  Right-click and open Properties.
3.  Select Security tab. 
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4.  Add 3 users: IUSR_<host>, IWAM_<host> and NETWORK SERVICE each with the permissions shown in the screen 
shot above.

5.  Select the Advanced button. 
6.  Select one of the users you added, and check the box indicated below - 'Replace permission entries on all child objects 

with entries shown here that apply to child objects'. Then click Apply. 
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7.  Repeat the above for the other two users.
8.  At the command line, run iisreset to restart IIS.
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  Legal Notices 

 

Hewlett-Packard  makes no warranty of any kind with regard to this document, including, but not 
limited to, the implied warranties of merchantability and fitness for a particular purpose. Hewlett-
Packard shall not be held liable for errors contained herein or direct, indirect, special, incidental or 
consequential damages in connection with the furnishing, performance, or use of this material. 

A copy of the specific warranty terms applicable to your Hewlett-Packard product can be obtained 
from your local Sales and Service Office. 

Restricted Rights Legend. 
Use, duplication or disclosure by the U.S. Government is subject to restrictions as set forth in 
subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause in DFARS 
252.227-7013. 
 
Hewlett-Packard Company 
United States of America 
 
Rights for non-DOD U.S. Government Departments and Agencies are as set forth in FAR 52.227-
19(c)(1,2).

Copyright Notices. 
©Copyright 1999-2007 Hewlett-Packard Development Company, L.P.

No part of this document may be copied, reproduced, or translated to another language without 
the prior written consent of Hewlett-Packard Company. The information contained in this material 
is subject to change without notice.

Trademark Notices. 
Java™ is a trademark of Sun Microsystems, Inc.  
Microsoft® is a U.S. registered trademark of Microsoft Corporation.  
Windows NT® is a U.S. registered trademark of Microsoft Corporation.  
Windows® and MS Windows® are U.S. registered trademarks of Microsoft Corporation.  
Netscape™ and Netscape Navigator™ are U.S. trademarks of Netscape Communications 
Corporation.  
Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, California.  
Oracle7™ is a trademark of Oracle Corporation, Redwood City, California.  
OSF/Motif® and Open Software Foundation® are trademarks of Open Software Foundation in the 
U.S. and other countries.  
Pentium® is a U.S. registered trademark of Intel Corporation.  

file:///C|/hpovreports/Help/Concepts_Guide/copyright.htm (1 of 2)3/16/2007 11:25:26 AM

Page 101



Legal Notices

UNIX® is a registered trademark of The Open Group.
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